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Introduction

Chapter 1 Unleashing the power of Excel with VBA

Barriers to entry

The macro recorder doesnt work!

No one person on the Excel team is focused on the macro recorder

Visual Basic is not like BASIC

Good news: Climbing the learning curve is easy

Great news: Excel with VBA is worth the effort

Knowing your tools: The Developer tab

Understanding which file types allow macros

Macro security

Adding a trusted location

Using macro settings to enable macros in workbooks outside trusted locations
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Using Disable All Macros With Notification

Overview of recording, storing, and running a macro

Filling out the Record Macro dialog box

Running a macro

Creating a macro button on the ribbon

Creating a macro button on the Quick Access Toolbar

Assigning a macro to a form control, text box, or shape

Understanding the VB Editor

VB Editor settings

The Project Explorer

The Properties window

Understanding shortcomings of the macro recorder

Recording the macro

Examining code in the Programming window

Running the macro on another day produces undesired results

Possible solution: Use relative references when recording

Never use AutoSum or Quick Analysis while recording a macro

Four tips for using the macro recorder

Next steps

Chapter 2 This sounds like BASIC, so why doesnt it look familiar?

Understanding the parts of VBA speech

VBA is not really hard

VBA Help files: Using F1 to find anything

Using Help topics

Examining recorded macro code: Using the VB Editor and Help

Optional parameters

Defined constants

Properties can return objects
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Using debugging tools to figure out recorded code

Stepping through code

More debugging options: Breakpoints

Backing up or moving forward in code

Not stepping through each line of code

Querying anything while stepping through code

Using a watch to set a breakpoint

Using a watch on an object

Object Browser: The ultimate reference

Seven tips for cleaning up recorded code

Tip 1: Dont select anything

Tip 2: Use Cells(2,5) because its more convenient than Range("E2")

Tip 3: Use more reliable ways to find the last row

Tip 4: Use variables to avoid hard-coding rows and formulas

Tip 5: Use R1C1 formulas that make your life easier

Tip 6: Copy and paste in a single statement

Tip 7: Use With...End With to perform multiple actions
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Chapter 3 Referring to ranges

The Range object

Syntax for specifying a range

Referencing named ranges

Shortcut for referencing ranges

Referencing ranges in other sheets

Referencing a range relative to another range

Using the Cells property to select a range

Using the Offset property to refer to a range

Using the Resize property to change the size of a range
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Using the Columns and Rows properties to specify a range

Using the Union method to join multiple ranges

Using the Intersect method to create a new range from overlapping ranges

Using the IsEmpty function to check whether a cell is empty

Using the CurrentRegion property to select a data range

Using the Areas collection to return a noncontiguous range

Referencing tables

Next steps

Chapter 4 Looping and flow control

For...Next loops

Using variables in the For statement

Variations on the For.Next loop

Exiting a loop early after a condition is met

Nesting one loop inside another loop

Do loops

Using the While or Until clause in Do loops

The VBA loop: For Each

Object variables

Flow control: Using If...Then...Else and Select Case

Basic flow control: If...Then...Else

Using Select Case...End Select for multiple conditions

Next steps

Chapter 5 R1C1-style formulas

Toggling to R1C1-style references

Witnessing the miracle of Excel formulas

Entering a formula once and copying 1,000 times

The secret: Its not that amazing

Understanding the R1C1 reference style
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Using R1C1 with relative references

Using R1C1 with absolute references

Using R1C1 with mixed references

Referring to entire columns or rows with R1C1 style

Replacing many A1 formulas with a single R1C1 formula

Remembering column numbers associated with column letters
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Chapter 6 Creating and manipulating names in VBA

Global versus local names

Adding names

Deleting names

Adding comments

Types of names

Formulas

Strings

Numbers

Tables

Using arrays in names

Reserved names

Hiding names

Checking for the existence of a name
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Chapter 7 Event programming

Levels of events

Using events

Event parameters

Enabling events

Workbook events
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Workbook-level sheet events

Worksheet events

Chart events

Embedded charts

Embedded chart and chart sheet events

Application-level events
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Chapter 8 Arrays

Declaring an array

Declaring a multidimensional array

Filling an array

Retrieving data from an array

Using arrays to speed up code

Using dynamic arrays

Passing an array

Next steps

Chapter 9 Creating classes and collections

Inserting a class module

Trapping application and embedded chart events

Application events

Embedded chart events

Creating a custom object

Using a custom object

Using collections

Creating a collection

Creating a collection in a standard module

Creating a collection in a class module
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Using dictionaries

Using user-defined types to create custom properties

Next steps

Chapter 10 Userforms: An introduction

Input boxes

Message boxes

Creating a userform

Calling and hiding a userform

Programming userforms

Userform events

Programming controls

Using basic form controls

Using labels, text boxes, and command buttons

Deciding whether to use list boxes or combo boxes in forms

Using the MultiSelect property of a list box

Adding option buttons to a userform

Adding graphics to a userform

Using a spin button on a userform

Using the MultiPage control to combine forms

Verifying field entry

Illegal window closing

Getting a file name

Next steps

Chapter 11 Data mining with Advanced Filter

Replacing a loop with AutoFilter

Using AutoFilter techniques

Selecting visible cells only
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Advanced Filtereasier in VBA than in Excel

Using the Excel interface to build an advanced filter

Using Advanced Filter to extract a unique list of values

Extracting a unique list of values with the user interface

Extracting a unique list of values with VBA code

Getting unique combinations of two or more fields

Using Advanced Filter with criteria ranges

Joining multiple criteria with a logical OR

Joining two criteria with a logical AND

Other slightly complex criteria ranges

The most complex criteria: Replacing the list of values with a condition created as the

result of a formula

Setting up a condition using computed criteria

Using Filter In Place in Advanced Filter

Catching no records when using a filter in place

Showing all records after running a filter in place

The real workhorse: xlFilterCopy with all records rather than unique records

only

Copying all columns

Copying a subset of columns and reordering

Excel in practice: Turning off a few drop-down menus in the AutoFilter

Next steps

Chapter 12 Using VBA to create pivot tables

Understanding how pivot tables evolved over various Excel versions

Building a pivot table in Excel VBA

Defining the pivot cache

Creating and configuring the pivot table

Adding fields to the data area

Learning why you cannot move or change part of a pivot report
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Using advanced pivot table features

Using multiple value fields

Grouping daily dates to months, quarters, or years

Changing the calculation to show percentages

Eliminating blank cells in the Values area

Controlling the sort order with AutoSort

Replicating the report for every product

Filtering a data set

Manually filtering two or more items in a pivot field

Using the conceptual filters

Using the search filter

Setting up slicers to filter a pivot table

Setting up a timeline to filter an Excel pivot table

Formatting the intersection of values in a pivot table

Using the Data Model in Excel

Adding both tables to the Data Model

Creating a relationship between the two tables

Defining the pivot cache and building the pivot table

Adding model fields to the pivot table

Adding numeric fields to the Values area

Putting it all together

Using other pivot table features

Calculated data fields

Calculated items

Using ShowDetail to filter a record set

Changing the layout from the Design tab

Settings for the report layout

Suppressing subtotals for multiple row fields
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Comparing VBA to TypeScript

Next steps

Chapter 13 Excel power

File operations

Listing files in a directory

Importing and deleting a CSV file

Reading a text file into memory and parsing

Combining and separating workbooks

Separating worksheets into workbooks

Combining workbooks

Copying data to separate worksheets without using Filter

Exporting data to an XML file

Placing a chart in a cell note

Tracking user changes

Techniques for VBA pros

Creating an Excel state class module

Drilling-down a pivot table

Filtering an OLAP pivot table by a list of items

Creating a custom sort order

Creating a cell progress indicator

Using a protected password box

Selecting with SpecialCells

Resetting a tables format

Using VBA Extensibility to add code to new workbooks

Converting a fixed-width report to a data set
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Chapter 14 Sample user-defined functions

Creating user-defined functions
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Checking whether a workbook is open
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Retrieving the user ID

Retrieving date and time of last save

Retrieving permanent date and time

Validating an email address
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Counting unique values

Finding the first nonzero-length cell in a range

Substituting multiple characters

Retrieving numbers from mixed text

Converting week number into date

Sorting and concatenating

Sorting numeric and alpha characters

Searching for a string within text

Returning the addresses of duplicate maximum values

Returning a hyperlink address

Returning the column letter of a cell address

Using SelectCase on a worksheet

Creating LAMBDA functions

Building a simple LAMBDA function

Sharing LAMBDA functions
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Chapter 15 Creating charts
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Specifying a chart title

Applying a chart color

Filtering a chart

Using SetElement to emulate changes from the plus icon

Using the Format tab to micromanage formatting options

Changing an objects fill

Formatting line settings

Creating a combo chart

Creating map charts

Creating waterfall charts

Exporting a chart as a graphic

Considering backward compatibility
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Chapter 16 Data visualizations and conditional formatting

VBA methods and properties for data visualizations

Adding data bars to a range

Adding color scales to a range

Adding icon sets to a range

Specifying an icon set

Specifying ranges for each icon

Using visualization tricks

Creating an icon set for a subset of a range

Using two colors of data bars in a range

Using other conditional formatting methods
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Formatting cells based on their value

Formatting cells that contain text

Formatting cells that contain dates

Formatting cells that contain blanks or errors

Using a formula to determine which cells to format

Using the new NumberFormat property

Next steps

Chapter 17 Dashboarding with sparklines in Excel

Creating sparklines

Scaling sparklines

Formatting sparklines

Using theme colors

Using RGB colors

Formatting sparkline elements

Formatting win/loss charts

Creating a dashboard

Observations about sparklines

Creating hundreds of individual sparklines in a dashboard

Next steps

Chapter 18 Reading from the web using M and VBA

Get credentials for accessing an API

Build a query in Power Query using the M language to retrieve data from the

web for one specific value

Refreshing the credentials after they expire

Building a custom function in Power Query
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Using the new function in your code

Duplicating an existing query to make a new query

Querying the list of songs on an album
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Simplifying the SearchArtist query to a single line of code

Simplifying the ArtistAlbums query

Simplifying the AlbumTracks query

Grouping queries to clean up the queries list

Planning the arrangement of query results on your dashboard

Using global variables and loops in M

Storing global variables in a Settings record in Power Query

Simple error handling using try with otherwise

Using If logic in M

Looping using List.Generate

Application.OnTime to periodically analyze data

Using Ready mode for scheduled procedures

Specifying a window of time for an update

Canceling a previously scheduled macro

Closing Excel cancels all pending scheduled macros

Scheduling a macro to run x minutes in the future

Scheduling a verbal reminder

Scheduling a macro to run every two minutes
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Chapter 19 Text file processing

Importing from text files

Importing text files with fewer than 1,048,576 rows

Dealing with text files with more than 1,048,576 rows

Writing text files

Next steps
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Using the CreateObject function to create a new instance of an object

Using the GetObject function to reference an existing instance of Word

Using constant values
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Using the Object Browser to retrieve the real value of a constant

Understanding Words objects

The Document object

Controlling form fields in Word
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access to data
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The tools of ADO

Adding a record to a database

Retrieving records from a database

Updating an existing record
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Checking for the existence of tables
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Adding a field on the fly
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CheckBox controls
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ToggleButton controls

Using a scrollbar as a slider to select values

Controls and collections

Modeless userforms

Using hyperlinks in userforms
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Sizing on the fly
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Nothing happens

Other ways to run a macro

Using a keyboard shortcut to run a macro
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Attaching a macro to a shape
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Running a macro from a hyperlink
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